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Initial Setup

File->My Company Information:

File I Edit Records Reports F

Setup

My Company Information

Exit Program

Cormpanyhame
Address1
Address2
City StatefProv Zip [ [

Zounkry

Phone | Fax | Tall Free

Defaul: Labor Charge Per Unit

Default Invenkary Markup Methad {~ Manual ¢ Fixed ¢ Percentage

Default Sales Tax % ™ Charge Sales Tax On Labar?

Close |

The information on this form is used to insert your company information into reports;
Company Name, Address, Phone, etc... is used to personalize various reports in TATEMS.
e The default labor charge — The information you enter here it will be the default amount
displayed on labor for new Work Orders.
¢ Default inventory markup method — This section allows you to markup your parts.
o If'you choose manual, you’ll have to manually enter your markup amount on each
part.
o Ifyou choose fixed, enter an amount to the right, then that amount (for example
$10) will be added to the cost of the part.
o Ifyou choose percentage, enter an amount in the box to the right, then that
percentage amount will be added to the cost of the part.
e Default Sales Tax — Enter an amount here to be used for Work Orders.
e Check the “charge sales tax on labor box” if your municipality requires you to charge
your customer sales tax on labor.



File—> Setup:
iEiIe I Edit  Records Reports F

I

S;i:up ||

My Company Information

| Exit Program

Click on “Change Global Inspections Items list”
J Change Global Inspection Interval
Change Global Inzpection tems List

J Change Global Years List

Equipment Type | Truck/Tractor =1 sddem | Updste Equipment | Close |

You should allways bachup your data before making changes here. Go to Toels->Bachup and Compact
Migirtenance tem s Copy Iters From Other Equipment Type |

Fire Extinguizher & Reflectors - Secured - Marked

Harn - Defrosters, Gauges and Speedometer

flirrors and Supports

Windshield Wipers - Window Cracks, Condition

Check All Lights - Turn Signals - Reflectors, Mud Flaps
Check Electrical Wiring - Condition & Protection

Check Batteries - Water Terminals and Cable

Warning Devices - Air, Qil and Temperature, Yacuum
Fadiatar & Water hozes - Condition - Leaks

Belts - Compressor(s), Fan and Water Pumg

e Equipment Type - You can add equipment types on the fly by typing into the dropdown
list for ex. Forklift, backhoe, delivery van, etc...) You should try to keep the equipment
types to a minimum. The more equipment types you add, the more resource intensive it
becomes to process the information.

e Maintenance Items - This list represents all the descriptions of equipment maintenance
items that might be inspected. You can add to this list by scrolling to the bottom and
adding in additional items. You can change items by highlighting and typing over. You
can delete items by clicking the square to the left of the item and pressing the delete key.

e Copy Items From Another Equipment Type — Utilize this button to copy a list of
maintenance items from an existing equipment type, to a new equipment type.



Change Global Inspection Interval

Thig setz the Inspechtion Interval Days for ALL EQUIPMEMT

Set Inzpection Interval Dayps

Inzpection Interval 90 DANYS

Cloze

This number must be greater than 30 and less than 366. It affects the inspection tab and
reminders associated with reminders. This changes Global for all equipment.

Change Global Year List

Add Year | Update Equipment | Close |
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This list of years is use to create inspections for each
piece of equipment for the number of years seen. If
you add additional years, be sure to click on the Update
Equipment button before you close.



Adding a New Piece of Equipment

These steps will explain how to add a new piece of equipment. Each field is addressed
individually. Grayed fields are not available for entering information. That field is populated
from other sources. See the individual field titles for further information.

e Click on the Records menu at the top of screen and choose Add New Equipment each
time to add a new piece of equipment. It’s going to ask you to enter a number that
identifies that piece of equipment. (Enter a#) You’ll get the following messages:

Note: Make sure that you are using a new number. Using an existing number could cause
problems with your records.

e “Please wait while a new record is created”. Click OK.

e “Equipment Number (the # you picked) added.” Click OK.

e “Since you’ve added a new piece of equipment, do you want to have the system  to re-
create the sort order?” Click yes if you want the sort order recreated.

Enter Description: For example: (1983 Ford F700 Water Truck)

Type: This is to enter the equipment type. For example: Truck/Tractor, Trailer, Fork Lift, etc.
There is a drop down list and if your selection is not there highlight the box and type it into add it
in on the fly.

|Descripl:iun Type | j
Note: If you are going to add Equipment Types then you should add all your Equipment Types

before you add more than a couple of pieces of equipment.
(See the “Change Global Inspection Items List” section under File-Setup)



Equipment Summary Tab

This shows all the info on any given piece of equipment provided info has been entered.

See “Adding a new piece of equipment™

Equipment Details Fields:
Enter Trucks/Trailers/Equipment to be tracked.

Fill in all pertinent info, not all fields need to be used. Check the “Out of Service” box if you do
not want this piece of equipment to show up on your reminders.

Equipment Details
Sart Order 2 [T oOuk OF Service?

H
Win Murnber |

—

u
o=
=

Year
Make
Model

Engine

apital Equip Mum

Purchase Crder Mum
Gas Card Num

|
|
|
License Plate Mumber |
|
|
|
|

Condition =1
Fuel Type l—;I

Unladen Weight |EI

Licensed Gr Weight |EI

Combined Gr Wweight [0

l

Aipfers ] Fitars ] Anzpactions/Parmits ] Wark Croars | Tiras/\Whaek
Equpment Summary | 9g-Day inspection | tubefService | Needed Maintenance/Repars | Repaivs Compieted | Pares For This Equip | Fuetiog |
Equipment Details ick Find | j Faorce Update
Sort Order =1 [ Out OF Service?
; Current 0dometer/Hours
Win Murmber |
Vear l— Odorneter Hours Log: Update Odometer
Odometer Date Hours Date: &nd Hours
IMake
Model i )
Engine | Lube/Service Type [Mext Mileage/km [Nest Howrs [Mest Date
License Plate Mumber |
Capitol Equip Mum |
Purchase Crder Num |
Gas Card Murm | 90 Day Inspection Dates
Condition | j a0 Dy Inspection Completion Date
a0 Day [ tion Required
Fuel Type - Mext 90 Day Inspection L shi et Gl
Unladen Weight 0
Licensed Gr Weight [0 Driver History | e T
Combined Grweight [ Driver Mum [Mame [Begin Thiz Equip] End This Equip %
Equipment Location e
Cust - 3
HStomer | J Coolant Testing
Location | j
0l Analysi
Department Or Area | ] Lonatel
: Double Click Driver History Lisk To Edit or Assign a Mew Driver to this Unit Mizc Details
i 2005 3.1.03F-P
Al TATEMS 2005 Best Viewed at a Screen Resolution of ot least 1024 x 768



Equipment Location:

There are 3 different fields that you can use. You can add different options to each list by
clicking on the box, and typing in what you want it to say and then hit tab, you will get a
message ‘“Not on the list, Do you want to add to list?” Click Yes.

Equipment Location

Cushomer [ |
Lecation [ =]
Dt O Ared | ;I

The customer field will show up on your Work orders. If you don’t service outside customers,
then you can choose “in house” as your customer. The customer, location, Department or Area
fields can be used to filter your searches in the equipment search section above.

Current Odometer/Hours:
Click on the Update Odometer and Hours button.

Current Odometer/Hours

Odometer Hours Log: Update Odometer
Cdomeker Dake Hours Date: and Hours

Update mileage or hours, depending on how you track that piece of equipment.

Click on Update & Close to complete the update.

It’s important to update your hours or mileage on a regular basis so that reminders that are based
on mileage or hours will be properly triggered.

Note: If you make a mistake, you can click the “View All for This Equipment” button to find
your mistake and delete it.

T ——— &
Odometer  Odometer Date Hours HourzD ate
Wigw Al F
Delete Record Thilsegquiprﬁ;nt Update & Cloze




Lubrication/Service: This info will be auto-populated from information entered into the
Lube/Service Tab.

Lubrication,/Service

Lube/Service Type [ Mest Mileagedkm | Meut Hours [ M et Date
Turne Up R3E5E6

90-Day Inspection Dates

The 90-Day Inspection Date fields will be auto-populated from information entered in the 90-
Day Inspection Tab.

90 Davw Inspection Completion Date

90 Day I kion Required
Mext 90 Day Inspection L St astEits e

Driver History:
Double click in the white area of the Driver History List to edit or assign a new driver to this
unit.

| Driver History |
Drriver Hum | Hame | Begin Thiz Equip| End This Equip

Double Click Here

Driver/Equipment Update

If the driver number is not in the list then
tyvpe a new driver number in the list and
press enter to bring up the Personnel Form

Driver Number | =]

ol e—

Marne

Driver On Equip Begin |
Driver On Equip End |

Add anaother Driver to Equip Mum 001 | Delete | Save and Close

{ Record: 14 | | 1 | 4 | | of 1

If you add a new driver number to the list when the personnel form pops up. Select the driver
check box to make sure that it shows up in the driver/equipment update screen. This allows you
to keep a running history of who was on the equipment and when. This can be useful, if you
want to keep track of who’s using your equipment, especially if you notice a high number of
repairs during a certain period.




Registration/Taxes Button

The dates and the intervals entered in the following screen are used to generate reminders for
those items.

Registration Due I __'_j
Last Reqistration Date !

Registration Interval Months iEI

Base License State/Province I _'_1

Last Mator Vehicle Tax Date !
Motor Vehicle Tax Interval Months ;EI

Last Highwway Ise Tax Date i

Highwway se Tax Inkerval Months iEI

License Feeas i$D.DD

=

Insurance Button

The dates and the intervals entered in the following screen are used to generate reminders for
those items.

|hzurance

Insurance

Insurance Company! |eico =

Insurance Last Renewed I

Insurance Renewal Interval Months ID

Insurance Armounk |$III.IZIIII

|

10



Financials Button

This is general information and does not generate any reminders.

Financials Financials

Lease Or Cwn | i i
Lease/Purchase Length Months |E|
Aquired Lease/Purchase Date I
Activated I
Inactivated I
Purchase Price |$D.DD
Equipment Yalue I
Other Fixed Cost I$D.DD
Depreciation |$D.DD
CIner I

04 I

Coolant Testing Button

The Coolant Testing screen is used to keep track of Coolant Test results.

Coolant Testing

Coolant T esting

Coolant Test Results

FreezePairt |
PH
Mitrake

Ik |

QOil Analysis Button

Enter when the Oil Analysis was completed and when you want it retested. No reminders are
currently generated from this screen.

0l Analysziz @il Analysis Testing

___0il Analysis Testing |

Test Completed @ I Miles | Hours
Re-Tesk i@ l Miles | Hours

(8]4 |

11



Misc Details Button

Informational only and will show up on the unit information report under reports—> current
equipments report

Mizc Details |

Other Misc Details
Mumber OF Axles ]
Mumber OF Seats i

et T
=

E [ Lift Axle Equipped [ Intra Stabe Unit

1 Tz axle Truck Puls Trailer [ Reefer/PTO Equipped
§ [ 2fade Trock Pulls SthWheel [T Unit Haul in Logs

[:

|

——

90 Day Inspections Tab

Adding a new Inspection

Click on Equipment Item# that you want to add an inspection for
e Click on the 90 Day Inspection tab

| Mepections/Permits ] Wk Crdars ] TiresfWitheels ]
LubaiSarvice ] Needed Manfenance/Repairs | Raepair Complated ] Parts For This EqGuip ] Aeiiog |

Niofes
Lguipment Summary |

Inspections Completed
Date Inspected [ Inspected By [ MileageKm [Haours

. Double click an Inspection Ikem in the List to view the details of that Inspection
Add Inspection

e Click on the Add Inspection Button

12



T |

Car Maiptenance & Satety Inspection |

lu -] [z008 -] inspectors Mame Odometer Due Dete Last Inspection

Month |l Year |2008 Date Inspected

Hours = This Maorth

Maintenance And Safety Rem hark &l Ok

DEF Motes -

v

Fire Extinguizher & Reflectors - Secured - Marked

| Haorn - Defrosters, Gauges and Speedometer

tirrors and Supports

Windzhield Wipers - Windowy Cracks, Condition

(Check All Lights - Turn Signals - Reflectors, Mud Flaps

(Check Electrical Wiring - Condition & Protection

Check Bstteries - \Wster Terminals and Cable

WWarning Devices - Air, Qi and Temperature, Yacuum

Fadistor & Wsater hozes - Condition - Leaks

Belts - Compressor(=), Fan and Water Pumg

Ajr Lines - Leaks, Condition and Protection

Fuel Tanks - Lines - Pump, Condition & Protection

Wanifold and Flange Gaskets - Muffler & Condition

B A T =
B A A I

Erriimm hden b 4 @ Brand bmmdem

Print Thiz Car Inzpection

Cloze |

When this screen opens the inspection you are viewing will automatically default to the current
month and year.

Select the month and year that the inspection was performed.

Enter the name of the person who inspected the vehicle.

Enter the mileage or hours. (Mileage for vehicles and hours for equipment.)

Enter the actual date inspected. (The date inspected must match the month and year
selected) TATEMS will automatically calculate the date for the next inspection in the
Due Date field. This date will appear on your reportts.

Click either the OK or DEF (defective) box placing a check mark next to each necessary
inspection field to indicate result of inspection. Or leave blank if not applicable.

Note: If you check it as defective, then that item will be copied to the Needed Maintance
Repair section.

Enter any notes pertaining to a particular item.

Click the print button to print out this inspection.

Clicking the Last Inspection button will provide information on the last inspection completed
for this piece of equipment, if there was a previous inspection.

Clicking the “This Month” button will return you to the inspection for the current month.

Opening an existing Inspection:

If there has already been inspections preformed, they will display as a list in the 90 day
inspection tab where it says inspections completed. Double click on any inspections listed to
view the details for that inspection.

13



Lube/Service Tab

Ninfax ] Fitars | MzpactiangParmits ] Wk Dedars ] Tiraz/Whesak |
Eguapment Summary ] B-Pay fnspection LubsfSarvice l Nieediad Maintenance/Repais | Repais Complated I Parés Far This Equip ] Fuefiog ]

=
=}
L
B
= & &
w Sl =]
S8 - 4= se -
= = £ F B o ]
= & om = Lo = o (g iy
Sort |by Date Oldest to Recent iz | ST O B £ 1 g & = 2 = T
; — o o = o
sccomplished -5 = el § B S
Luke/Service Type Date Qdometer Hours By ‘i‘ (@] o 3 [ moMm g = om D
3 | | [ B w E R E B E & B B | EE B
Mates Other |

4| | ]

The lube/service tab is important to use in order to create reminders, even if you have a new
piece of equipment you’ll need to enter something in here to generate a reminder for the next
lube/service that needs to be done.

e Enter the Lube/Service Type — Use drop down list or type in your own description. You
can create multiply service types for each piece of equipment. Ifthe Lube/Service type
you need is not in the list, you can type it in to add it to the list. When you add a new
Lube/Service type to the list for example “12,000 mile service” and press the tab or enter
key you will be prompted to add it to the list. A series of 3 prompts will display after you
click ok — you will be asked for the mileage interval, the hour interval, and the day’s
interval. If the Lube/Service type is based on mileage then when you see the prompt for
hours and days you can click ok to bypass them.

o Enter the date of the lubrication.

e Enter odometer or hours — Odometer reading for vehicles/hours for equipment.

e Enter the name of the person who performed the lubrication.

e Click on a box beneath the item, placing a check mark in it to indicate which item was
completed. (You may also tab through the box fields and use the Space Bar to place the
check mark.)

¢ Boxes labeled A, B & C cannot be changed and most companies have an industry
standard or custom list of maintenance items that correspond to a; A schedule, B schedule

or C schedule.

e The Sort function allows you to sort your entries.
14



Displaying on Reports:

The Lube/Services will be displayed on the following reports:

Reports = All Equipment Reports = All Equipment due next 30 days
Reports = All Equipment Reports = All Equipment last/next maintenance
Reports = Current Equipment Reports 2 Lube & Inspection Report
Reports = More Reports > Report Type = Lube/Service

The report printed from the Reminders popup screen

M

Needed Maintenance/Repairs Tab
Nofaz ] Sitars | Ingpachions/Parmits ] Wamk Ordaes | Traz/Wheais ]

Fqupment Summary | S0-Bay inspection ] fubafsarvire Niseded Maintenance/Repais l Repairs Compiated | Parte For This Squip ] Fuetiog ]

IUse this section to keep track of any mainkenance or repairs vou need to schedule For this equipment

] . o Complete By Completed
Scheduled Maintenance/F epair Description [Date [rate

[ 2 % 0K to transfer over to Repairs

The Needed Maintenance/Repair section allows you to keep track of any maintenance or repairs
you need to schedule for this equipment. Some users use the Needed Maintenance/Repair tab,
the Repairs Completed tab and the Parts for this Equipment tab instead of Work Orders. Some
users like to use both Work Orders and these tabs, the choice is yours.

¢ Adding a new Maintenance/Repair Item: Type in the description and the completed by
date. The maximum number of characters including spaces is 200.

e Completed Date: Once you have entered a completed date, the item will no longer
display on the Needed Maintenance/Repairs report.

Displaying on reports:

The Needed Maintenance/Repairs Reports will be displayed on the following reports:
1. Reports = All Equipment Reports = Needed Maintenance/Repairs
2. Reports = More Reports = Report Type = Needed Maintenance/Repairs.
3. Reports = All Equipment Due next 30 days reports under

15



Transferring to Repairs Tab: Click on the “OK to Transfer to Repairs” tab when you
want to transfer the information over to the Repairs Completed section.

Automatically adding from 90 Day Inspection’s: When you click an item as defective
while doing a 90 day inspection, that item will automatically transfer to the needed
Maintenance/Repairs tab

Repairs Completed Tab

Nofes ] Fitars | Ingpections/Parmis I Wark Srdlars | Tires/Wheeis ]
Equipment Summary ] B-Bay fnspection ] LubefService ] Needed Mantenance/Repars  Repais Complated ] Farts For This Sgup ] Fueliog |
This section can be used instead of or in addition to Work Orders
Hanars Odometer Hours Date Cost
> I
Sum of Repair Costs for this Equipment for |41 ears P[]

The Repairs/Completed section allows you to keep track of any repairs completed on this
equipment. Some users use the Repairs Completed tab, the Needed Maintenance/Repairs tab and
the Parts for This Equipment tab instead of Work Orders. Some users like to use both Work
Orders and these tabs, the choice is yours.

Adding a new Completed Repair Item: Type in the description and the completed by
date. The maximum number of characters including spaces is 200.

Odometer: Enter the odometer reading at the time of the repair

Hours: Enter the hours on the equipment at the time of the repair

Date: Enter the date when the repair was completed

Cost: Enter the total cost of this repair

Sum of Repair Costs for this Equipment: (located in bottom right corner) Select a year
(either all years or a single year) to display a total repair cost for this piece of equipment.

Displaying on reports:
The Repairs Reports will be displayed on the following reports:

1. Reports = Current Equipment Reports > Repairs Report
2. Reports = More Reports = Report Type = Repairs Completed.

16



Parts for this Equipment Tab

|

Aiofax ] Giters ] MzpactiansParmits ] Wriek Degars | Tiraz/Wwhealr
Equpmant Summary ] B0-Day fnspection | LubefSarvice I Needad Maintenance/Repais I Repais Completed  Parts For This Equip ] Fuellog ]
; This parts section is used to keep a quick reference list or 2 total of parts used in this equiprnent

Date Filker

BeginDate [ 6/12/2006 EndDate | 77122005 Fiter | Showan | | Sot  [byDateInstalled Oidest to newest —_~ |

Part # Part Description Patt Yendar Manufacturer  Date Installed Gty Park Cost Total Cost ‘Warranty  Work Ord
b | | | | [ ofom | gm0 T ]
« | B

Sum Parts Costs Far This Equipment: [411 Years ]

The Parts for this Equipment section allows you to keep track of any parts used on this
equipment. When this section was first created, it was used primary for a quick reference to
commonly used parts. However it can be used to track all parts used for this equipment. You
can transfer a copy of the parts used in a Work Order into this section.
This section will not pull parts from your parts inventory. Some users use the Parts for this
Equipment tab, the Repairs Completed tab and the Needed Maintenance/Repairs tab instead of
Work Orders. Some users like to use both Work Orders and these tabs, the choice is yours.

e Part #: Enter text or numbers up to 50 characters
Part Description: Enter text or numbers up to 150 characters
Part Vendor: Enter text or numbers up to 50 characters
Manufacture: Enter text or numbers up to 50 characters
Date Installed: The date the part was installed on this equipment
Quantity: Numeric value representing how many were used
Part Cost: Cost of part
Total Cost: This is automatically generated
Warranty: Check if it applies
Work Order ID: This field will be filled in automatically if you copy the part from a

Work Order, you can double click in the Work Order ID field to display the Work Order

that this part was used on
e Date Filter: When the program first opens the begin & end date will default to the past

30 days. To change the begin/end dates, click on the filter button to show parts used in a

different time frame. You can use the show all button to show all time frames.
e Sort: There is a number of sort criteria to pick from

Displaying on reports:

The Parts for this Equipment Reports will be displayed on the following reports:
1. Reports = Current Equipment Reports = Parts Report
2. Reports = More Reports = Report Type = Parts Installed
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Fuel Log Tab

Aiotes ] Fitars ] AnspactionsPermits l Work Oralars ] TiresiWhasl
Egeipment Summary ] Bi-Ray fnspeckion ] Lube/Service ] Needed Mainfenance/Repars ] Repais Complefed ] FParts For This Equip Fuallog

tilezdKm -
. Beagin Current Miles/Em  Start/Stop Price Per Per
Fuel Station'endar Odometer Odometer  Traveled State/Prov GallonsiLt GallonLtr  Gallon/Ly Cost Entry D ate PO Mum
= | |D State/Prov I | | | | |
=5 | | State/Frov I | | | | [
Choose Date Criteria Tatal For This Criteria Overall Fuel Log Stats
Fuel Log Dates to View Tatal Gallans/ Lt 1] Tatal Gallans/Le 1]
From E/12/2008 Tatal Milez/Km 1] Tatal Miles/fm 1] <-Updats
o T Cast Per Mile/Km $0.00 Cast Per Mile/Km $0.00
’ Miles/Km Per Gallon/Ltr |0.00 Miles/Km Per Gallon/Ltr |0.00 =
t
Update Date Citeria | Total Cost $0.00 Total Cost $0.00 _ Fin |

The fuel log allows you to keep track of various items relating to fuel for each piece of
equipment

e Fuel Station/Vendor: Select an existing Fuel Station/Vendor or type a new one in the
field to add to the list. Enter text or numbers up to 50 characters

e Begin Odometer : Enter the odometer reading at prior fill up

e Current Odometer : Enter the odometer reading at this fill up

e Miles/Km Traveled : Automatically generated

e Start/Stop - State/Prov : Click on the State/Provence button

State/Province Mileage/Km
Enter State/Provice-Cdometer Readings For this trip

StatefProvince Beqin Odometer End Odometer

| & 0] 0

Close

Select a State/Province from the list or type a new one in the field to add to the list.
Enter Beginning Odometer and Ending Odometer readings.

e Gallons/Ltr: Enter # of Gallons/Liters used.

e Price per Gallon/Ltr: Enter Price per Gallon/Ltr.

e Miles/Km per Gallon/Ltr: This is automatically generated.

e Cost: Automatically generated. You can override this amount
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e Entry Date : Automatically generated when you select a fuel station vendor

e PO Num : Numbers or letters, Maximum of 50 characters

e Choose Date Criteria: When you first open TATEMS, the “From Date” criteria defaults
to 30 days prior to the current date. The “To Date” defaults to the current date. Change
these two dates to view fuel log entries and totals for any time period.

o After you have altered the dates click on the Update Criteria button to update results

e Overall Fuel Stats : Will display all fuel stats for this piece of equipment regardless of
date criteria chosen

e Update Button: m This will force an update of all totals.

e Print Button: Will print out a report of fuel log information for this piece of equipment
based upon the date criteria chosen.

Notes Tab

Eguipmant Summary ] Ba-Day nepection ] LubefSarvia ] Needed MaintenancesRepais | Repais Complated ] Fartz For This SEguip | Fuellog |

Ables Fitars | nEpections/Parmis ] Wk Qrdars ] Tires/Whasalk ]
Mote Test Mote Date
» ~ 17242006

*

Here you can enter any kind of note regarding the piece of equipment.

Enter text or numbers up to 255 characters.
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Filters Tab

Lqupmant Summary | Bo-Ray nspeckion ] Luba/Sarnice ] Niseded Manfenance/Rapais | Repaiw Complafed | FParts For This Equp ] Fuafiog ]

Niofes Filters l Anspachions/Parmis | Wk Ovdlers | Tires/Wheatr

Lube Ol Filkers

Prirnary l— Mizc Filkers
Secandary I—
Hydraulic l—

Air Filters Trans l—
Outer ‘whater
Inrer Other Filters

Fuel Filters

Frimary
Secandary

Print These Filters

Additional information regarding filters can be entered here.

Lube Oil Filters: Enter text or numbers up to 25 characters.

Air Filters Enter: Enter text or numbers up to 25 characters.

Fuel Filters Enter: Enter text or numbers up to 25 characters.

Other Filters under Misc Filters: Enter text or numbers up to 75 characters.
Print These Filters Button: Click to print filters for this piece of equipment only.

Inspections/Permits Tab

Lqupmant Summary ] B-Day fngpection ] LubaiSaria ] Neaded Mantenance/Rapais | Repair Compieted ] Fartz For This SEquip ] Fugfiog [

Niofar ] Fitars Ingpections/Pesmis | Wark Oraaes | Tires/Wheals

DOT Inspection DOTInspection Interval 365 Mext DOT Inspection Due FAz2s2007

90 Day Permit 90 Day Permit Interval 90 Mext 90 Day Pemit Due 1041042006
Annual State Annual State 365 MestAnnual State FA242007
Inzpection Inzpection Interval Inzpection Due
Over Axle, Over Gross, Owver Anle, Ovver Gross, J65  Mewt Over Axle, Over Gross, FA242007
Over Tollerance Permit Ower Tollerance Permit Oever Tallerance Permit Dus

Interval
Motor Carrier Certificate Motor Carrier Certificate 365 Mest Mator Carrier 7202007
Registration Registration Interval Certificate Fegistration Due
Periodic SmolkefCVIP Periodic 369 Next Perodic Smoke/CYIP TAZ2/2007
Inspection Smoke/CVIF Inspection
Completion Date Inzpectain Interval

Print Inspections/Pemits For &ll E quipment |

[ Periodic SmokeCYIP Inspection Required

The first column is a date field. Enter the date of the last inspection/permit.
The second column — enter the number of days between inspections.
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e The third column will show you the date when the next inspection/permit is due.
e Periodic Smoke/CVIP Inspection Require: Check if you want to have them appear on
reminders.

e Print Inspections/Permits For All Equipment Button: For all inspections/permits for all
equipment

Work Orders Tab

Lgupmant SLmmary ] Bi-Ray fngpection ] LubadSarwia ] ANeeded Maintenance/Repairs | Repais Compieted ] Parts For This Equip i Fuafiog |
Notes ] Fitars | Ingpections/Fesmis Work Ordars | Tiras/Wheals
Lisk Display |AII Orders For This Equipment j Sork |b_l,J Date Reguested Hewest To Oldest j
Wk Orderi] Dt Fiequested] Complats By Dt [ Ref Hum [ Description [Serviced By [ Dt Completed
<] 2+
To Yiew the details of a Work Order double click on it in the list
Mews work Order

Click on New Work Order Button to add a new Work Order.

: Work Order
workOrder D |9 Customer | Requested Date  |7/13/2006

E quip Mum oot Location | Requested By
Reference Department Or Area | Complete By Date

Description | Labor Completed ] Partz Or Material Used | | Was this work for: |
Eguip Dezscription |\-'ehic:|e [ “Wamanty?
Serviced By [ |

Shart Description(z) j [ i

1 Completed Date li
Completed Mileskm li
Completed Eq. Hours Ii
Labior ’W
Detailled Dezcription B J $0.00
Fartz Or M aterialz ,W
Discount JW
Tax 7.25% [ sooo
Grand Total ’W

Update Totalz
| Print Delete and Cloze Cancel and Cloze Sawve and Cloze

-

™  PRecal?
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e  Work Order ID: When you open a new work order the Work Order ID # is auto
generated. It will increase by 1 every time you open a new work order even if you
deleted the one previous.

e Equipment Num: Cannot be changed, this is pulled from the current equipment you are
viewing.

e The Reference field: is for you to use as you see fit. Maybe you would like to reference
this work order to something else. Maximum of text or numbers 30 characters

e Customer, Location & Dept: This information is from information entered on the
Equipment Summary Screen for this piece of equipment.

¢ Requested Date: Automatically generated when you start a new Work Order and
defaults to the current date. This can be overridden. This can be used in some of the
Work Order reporting criteria.

¢ Requested By: Enter the name of the person who is requesting the Work Order. 30
characters max.

e Complete By Date: Enter the date the Work Order should be done by. The date entered
will be use to show all Work Orders Pending in the All Equipment due in 30 days report.

e Serviced By Field: Enter the name of the company or shop that serviced the piece of
equipment.

e Warranty / Recall: Check if it applies

e Completed Date: Enter the date the Word Order is completed. This date is used in
reporting criteria

e Completed Miles/km: Enter the Odometer reading on the equipment at the completion
of this Work Order.

e Completed Eq. (equipment) Hours: Enter the hours metered on the equipment at the
completion of the Work Order.

e Total Cost:

o Labor: Labor costs are pulled from the Labor Completed tab

Misc: Misc costs can be entered at will.

Parts or Materials: Costs are pulled from the Parts or Materials Used tab.

Discount: Enter amount that you would like to discount this order.

Tax Percentage: Is calculated based upon what you entered in the “My Company

Information” section. This can be overridden.

o Grand Total: Cost is automatically calculated when you click on the Update

Total Button, __UpdateTaids |

o Print Button: Click the print button to preview and print the Work Order either
as a pending Work Order or a completed Work Order, depending on whether the
completed date has been filled in or not.

o Delete and Close Button: Click this button to delete the entire Work Order and
close the screen.

o Cancel and Close: Will close the Work Order without saving changes.

o Save and Close: Will save changes and close screen.

@)
@)
@)
@)

W/O Description Tab:
o Equip Description: Cannot be changed and is pulled from the Equipment
Information.
o Serviced By: Enter either in house or outside vendor info. Max 40 characters
o Short Description: Enter a short description. Max 80 characters. As you add
multiple short descriptions the numeric field will automatically count up. The
dropdown list is automatically added to each time you add new short description.
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Keep your short descriptions as generic as possible to avoid creating a lengthy
list.
o Detail Description: Larger description. Max 64,000 characters.

W/O Labor Completed Tab
Description  Labor Completed | Fartz Or b4 aterial Llsed]
Unitz | Description [ Uit Cost [Total Cost [Done By
080  Replace Transmision $35.00 $17.50 Yendor
< ¥

Double Click an item in the list to edit that item

Click Here Add Labor to this Work Order

The list will be populated with all of your labor items.
e To add a labor item: Click the button

f

- I

Labor For Current Work Order

Click on a tazk listed for view detailz

itz [ Description [ Urit Cost
h0.00 Replace Diriver Lower Swin $35.00

EI—

Unitz 0.o0 Cost Per Unit {$35.00 Taotal Cost [$0.00

Performed By % Employes " Wendar
Enter Employes | B

Search Descrigtions |

Description j
| Motes
i
| Add Labor to Work, Order Delete Save & Cloze

When the labor for Current Work Displays enter the pertinent information pertaining to each
labor item
e Units: This can be put in as whole numbers or decimals and is a required field. If you do
not enter units the labor will not be entered to the Work Order.
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Cost per Unit: This amount is automatically pulled from the “My Company Info”
section under file menu and can be overridden.
Total Cost: Is automatically calculated.
Performed By:
o Employee: Check here if Employee performed. A drop down will display a list of
employees to pick from, from your personnel records under Forms—>Personnel.
You can add employees to the list if not already there. When adding employees
to the list there will be a series of 3 prompts. First Name, Last Name, Assigned
Employee Number provided by your company.
o Vendor: Check if Vendor performed
Search Description: Required field. Enter a description of the labor. Maximum 50
characters. If you do not enter a description the labor will not be saved to the Work
Order.
Search Descriptions Button: Use the search description button to popup a search screen
to help you find the description you are looking for.
Notes: Enter any notes pertaining to this labor task. Maximum 255 characters.
Add Labor to Work Order Button: Click this button to add this labor entry to the Work
Order and to continue adding labor entries without closing this screen.
Delete Button: Used to delete the currently viewed labor entry.
Save & Close Button: Save item and close the screen.

W/O Parts or Material Used Tab
Description | Labor Completed  Parts O Matenal Used |

Oty | Part Hum | Dezcription | Unit Cost] Tatal Cost | Parts Vendor] ' ananty?

:

7893 Headlight for MAC  $226.00 $226.00 | HdAmerca Mo

Double Click an item in the list to edit that item

Click Here to Add Parts or Materials to this Work Order

Click Here ta add theze parts to the master partz list uged for thiz equiprment

Click the “Click Here to add Parts or Materials to this Work Order” Button to open a pop
up screen that allows you to add Parts or Material s to this Work Order.

Click the “Click Here to add these parts to the master parts list used for this equipment”
button. If you want to add the parts used in this Work Order to a running list of parts
used on this piece of equipment. They will be copied over to the Parts for this Equipment
section.
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Parts For Cumrent Work Order .

Click on a Part lizted for view details

[ Part Mum
a9a

| Dezcription
Headlight for MALC

iy
1

Fart/Stock Mum |?898
Gty 1.00 [ Deduct From |mventary 7

Cozt Per Unit [$225.00 Total Cozt [$225.00

j More Search Inventory

Parts Wendor |Hd Amenca ]
[ | Warranty
Manufacturer |Eallisle j
Dezcnption |Headlight for MarC
Mobes
Add Part To Work Order | Delete | Save & Cloze |

This is the screen that pops up to add Parts or Materials to the Work Order.

Parts/Stock Num: Required field. Type in a parts stock number or pick one from the
drop down list. You can add a new number by typing it in. Follow the prompts to add
the parts to the list. Max. 50 characters, text or numbers.

More Search Inventory Button: Click here to bring up a list of part #s

.
A

| |I:u\,-' Part Murn j Sork by Part Mum -

Park Murm | Descripkion | Yendor | Cosk ﬂ

7898 Headlight For MAC Hd America $150.00

Cilz0 1 Quark af il Autozone $2.75

759398 1 Quart of 10-40 Matar Sil | Autozone $z.52

Q5656 sdsdsds $0.00

dfgdfgd 40,00

dsfdsfds $0.00

sdfsdfdf $0.00 ﬂ

Double Click on the part you are looking for to add it to the Work Order
Cpen Parts Invenkory Cancel and Close

e Qty: Required field. Whole numbers or decimals.
e Deduct From Inventory: Check if yes.
e Cost Per Unit: This is pulled from the Parts Inventory list and can be overridden.
e Total Cost: Automatically calculated.
e Parts Vendor: Automatically auto-populated from Parts Inventory and can be

overridden. Maximum 25 characters, text or numbers.
Parts Manufacturer: Automatically auto-populated from Parts Inventory and can be
overridden. Maximum 30 characters, text or numbers.
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Warranty: Check if it applies.

Description: Maximum 50 characters

Notes: Maximum 255 characters.

Add Part to Work Order Button: Click this button to add this Part entry to the
Work Order and to continue adding Part Entries without closing this screen
Delete Button: Used to delete the currently viewed Part entry.

e Save & Close Button: Save entry and close the screen.

Displaying on reports:
Reports = More Reports = Reports Types = Work Orders
There are 9 reports to choose from in this section.

Tires/Wheels Tab

Euipment SLmmary ] 93-Ray fnzpection ] Lube/Service | Needed Mantenance/Repais | Repars Complefed | Partr For THiF Eguip | Fueifog ]
Notas ] Fters | inspections/Permits ] Wark Ordars Trag/Whesk

Tires Installed On This Equiprent

: : . . Install Location On
Tire Manufacturer — Tire Model Tire Size Odometer &t Install — [Installation Date Equiprmett

o || = [0 | | JE2|

Frint Tires & Wheel
Wheels Installed On This Equipment M

. Odometer At Instal Inztall Location On
"wheel Style wheel Type Size Install D ate Equipment

o || JEd || [0 | | JE2|

Enter information regarding Tires & Wheel
e Tires Installed On This Equipment:
o Tire Manufacturer: Select from the drop down list or enter a new one. Max 25
characters
o Tire Model: Select from the drop down list or enter a new one. Max 30
characters
Tire Size: Key in the tire size. Max 20 characters.
Odometer At Install: Odometer reading at time of installation.
Installation Date: Date of installation.
Install Location On Equipment: Enter where the tire was installed on
equipment. For example “left front”. Max 20 characters.

O O O O

e  Wheels Installed On This Equipment
o Wheel Style: example “10 hole” Max 30 characters.
o Wheel Type: example “Bud, Dayton or Pilot. Max 30 characters.
o Size: example “22.5” Max 20 characters
o Odometer At Install: Odometer reading at time of installation.
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o Install Date: Date of installation.
o Install Location On Equipment: Enter where the wheel was installed on the
equipment. For example “left front”. Max 20 characters.

e Print Tires & Wheels Button: Click the Print Tires and Wheels button to print a list of
all Tires and Wheels installed on this piece of equipment.

Toolbar Menus

File Edit FRecords Reporks  Forms  Tools Window  Help

Edit
i Edit | Recards Reparts |
| Edit Equipment I

Edit Equipment ID: The equipment ID field on the main form is normally locked and cannot be
edited. You can use this menu item to edit the Equipment # field.

Records
i_-Recctgs_i_B__g_pDrts Forms
‘ Add Mew Equipment

Delete Equiprment

Add New Equipment: Use this menu item to add a new piece of equipment to the database.
Delete Equipment: Use this menu item to delete the currently displayed piece of equipment
from the database.

Reports

i EE[LUSH:S | Forms  Tools  Window
Al Equiprment Reports 3

Current Equiprent Reports #

More Reports

(&

To Preview the report click on the icon |

&

To Print the report click on the icon
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Reports | Forms  Tools  Window

‘ All Equipment Reports [ P || [&  AlEquipment Summary Reports | Forms  Took ﬁindﬂu
Current Equipment Reports » | &k All Equipment Summary All Equipment Reports b
Mare Reports E)‘ All Equipment LaskiMext Mainkenance Curﬁnt Equipment Reparts » @ Equipment Maint, & Safety Report
& Al Equipment Last Mext Mantenance Mor?gﬂeports El Equiprient Maint, & Safety Report
& All Equipment Due Mext 30 Days ;
@ Lube & Inspection Repart
% All Equipment Due Mext 30 Days
) ) & Lube & Inspection Repart
E{ Meeded Maintenance /Fepairs
% Meeded Maintenance/Fepairs & Repairs Repart
E{ All Equipment Filters E{ Repairs Repart
% All Equipment Filters @_ Mokes Repart
E}_ All Equipment: List E’. Parts Report
All Equipment List ; !
S ALl El Unit Information Report
(& AlFiers List
&b Al Filters List

Sepors | Forns _Todls _ o

Al Equiprnent Repaorts » Repoit Type: [N ]

Redquires & Periodic or 90 Day Inspection
Requires A Periodic or 30 Day Inspection by Customer

Current qu-"pment REpDrts L4 Inspections and Permits Due in a particular month
Inspections and Permits Due or Past Due
[ Ml:lrE REpDrtS Equipment Location /Dept/Area

Additional Reports ——>
These reports will change
To fit the screen you are on.

Close

e Before you can generate a report. You need to make a selection from the list of available
reports after you choose a Report Type.
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Forms

Faorms | Tools  Window  Help

Cuskomers

Dropdown List Mainkenance
Parts Inventory

Personnel

Hazardous Waske Inspection Log

Reminders Popup

Forms/Customers

Farms | Tools  Window  Help

L[}g Cuskomers

Dropdown List Mainkenance
Parts Inventory

Personnel

Hazardous Waske Inspection Log

Reminders Popup

e Add a new customer: To add a new customer, fill in the information. Click add new or

save & close

[Ery Tame | Sart [Mame -]
Name [Cit [Phone [Tnactive?
In House Mo
on location Mo
in garage Mo
Customer Details

Customer #

Marme JIn House

Address |

Address 2 |

City |

StatefProv | ]

Zip |

Fhone |

Contack

Inactivate H
Add Mew ‘ Save and Close ‘

e Search for a customer: Use to find a customer.

e Inactivate a customer: When you click to inactivate a customer, the customer no longer

shows up in the dropdown list on the Equipment Summary screen. However, if a
customer is still linked to a piece of equipment, then that customer will still display on
the Equipment Summary page until a different customer is selected for that equipment.
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Forms/Dropdown List Maintenance

--Fcurms -| Tools  Window  Help

Cuskamers

| Dropdown Lisk Mainkenance 3 |

[
Parts Inventory ME
Personnel

Hazardous Waste Inspection Log

Reminders Popup

Forms/Parts Inventory

Farms | Tools  Window  Help

Condition
Departrment or Area
Equipment Tyvpes
Fuel Type *
Fuel Yendors

Insurance Companies

Labor Descriptions

Labor Wendors

Lease Or Owin

Lacation

Lube/Service Types

Parts Yendors

Repair Type

Serviced By Yendors

States and Provinces

Tires Wheels Install Locations
Tire Manufacturers

Tire Models

wheel Styles

wheel Tvpes

Waork Qrder Short Descriptions

Cuskomers

Dropdown List Mainkenance

[ Parks Inventory

Personnel
Hazardous Waske Inspection Log

Reminders Popup

Utilize each of the
Dropdown List
Maintenance items to pop
up a screen that will allow
you to edit various
dropdown lists within the
program

,— Search |bv Part/Stock #

j Sart |hy PartStock #

J Display |Active j

Headlight For M

Seling Price  |$35.00

7595 L56S Catlisle ACCessories

Gil3a SAE3D Tobil Fluids 1 Quart of il 1]

739395 P10-40 Penzoil Fluids 1 Quart of 10-40 Motor Oil 50
PartStock # E556 Type [ =1
Manufackurer PE# Manufacturer| =1
Part Description |Front Brake Pads
Part Cost $35.00 Part Yendar | |

" Manual & Fixed Increase ( Percent Increass |0

[ Inactive?

[T Track Inventory on this part?

Current Quankity OnHand [0 Date Quantity On Hand Verified

Minimurn Quantity Before Re-Order |0 Quantity On Re-Crder |0

Add Mew Part

Date Re-Ordered

Close

Update | Delete |

¢ Enter: Parts/Stock #, Type, Manufacturer Pt#, Manufacture, Part Description,
e Part Cost: Actual Cost of part.
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Part Vendor: Select a Vendor.

Selling Price: Will automatically default if you choose a fixed or percent increase in the
“My Company Information” section. This can be overridden for each individual part.
Track Inventory on this Part: Check this box if you want to be reminded when
inventory gets low on this part.

Inactive: Check this box when you want to make the part inactive, but not deleted from
system.

Current Quantity on Hand: The physical count of # of parts on hand.

Date Quantity on Hand Verified: Date inventoried.

Minimum Quantity before Re-Order: Enter the minimum amount you want to have on
hand before needing to re-order. When you hit that number a reminder will pop-up.
Quantity on Re-Order: How many you re-ordered.

Date Re-Order: Enter the date you re-ordered.

Delete Button: If you delete a part from the Parts Inventory that has already been added
to a Work Order, then that part will be deleted from the Work Order. This will skew your
Work Order totals.

Forms/Personnel

Farms | Tools  Window  Help

Cuskomers
Dropdown List Mainkenance

Parts Inventory

Personnel

T

Hazardous Waske Inspection Log

Reminders Popup

e CDL Renewal: Those dates are used to generate reminders
e Next Physical: Those dates are used to generate reminders

e Personnel Type:

|by Firsk Mame

-] Sort |hy First Mame = |

Assigned Num| Firsk Mame |Last MNarme

[ 0L Mum [Phane

| Inackivate?

A565 Barney Fubble
4565 Jack Jones
£

Assigned Num [4565

First Marne Jack.

Lask Marne Jones

Driver Phone  |{555) 555-1212

el [5E5) 555-1234

Personnel Type

W Driver [ FleetTechnician [ Other

D2326464

5555658989 No

ASGE5E5E56 SE55551212 Mo
2
DL Murn ASESE5656

CDL Renewal |12/20/2006

Last Physical  |12/20/2003
Mext Physical  |12/20/2006

Description

Mokes |Type up ko 255 characters

Hire Date |12/20/2004 Seperation Date Inactivate [~

Add Delete

Close

o Driver: For an employee to show up as an available driver, the driver box must be

checked.

o Fleet Technician: Must be checked in order to display on the employee list when
add labor to a Work Order.

o Deleting: If you delete an employee that was linked to a piece of equipment or
Work Order, then the history of that employee will be deleted as well.
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Forms/Hazardous Waste Inspection Log

Farms | Tools  Window  Help

Cuskomers
Dropdown List Mainkenance
Parts Inventory

Personnel

£ TATEMS 2005 Version 3.1.03{XP - [Hazardous Waste Inspection Log]

Flle Edt Records Reports Farms  Tools  Window  Help o 5y

Close

Hazardous Waske Inspection Log

Reminders Popup

e Simply follow the
mstructions on the form.

Hazardous Waste Inspection Log
4 check mark in column "8" below ndicates tha the undersigned employes inspected the hazardous
wasle area to insure compliance with the relevant standards in the following aieas:
1. There are na spills currentl in progress
2 Anp splls have been cleaned up and the area is absent any standing fluids.
3 All hazardovs waste cortainers are closed and have good integrly
4 Al containers are labled with the words " hazardous waste” . generator name and address, contents,
hazardous properties, physical state and accumiafion date,

The hazardous waste inspection shall be done weekly for container storage aieas and daiy for aboveground

tank areas.
4. Date B. Inspection  C. Employee [ Comments

] \ ]
Choose Dates to View
From 6/19/2006

View These Dates Orly Pint Current List

To 7119/2008

Record: 14 1 M o 1

Farm View M

32



Forms/Reminders Popup
Remiders
Farms | Tools  Window  Help

Double Click on an i ; Close Prink This List
Cust E quipment Murn to go Edlthwoa;:g 1E] R emin d ers —
HLRMELS it Fopup Reminders Every |5 Hours -

Dropdown List Mainkenance 3

Equip Mum |Equip Diesc |Last Inspection Completed [Mext Inspection Due
Parts Inventory
Personnel

i i i ip. In List™

HEIZEIFEIDLIS Wacke II'ISI:IEl:tIEII'I Ll:lg Prinkt Inspection Forms For All Equip. In Lisk ‘ Lube,Service Reminders

Equip Mum |Equip Desc \Current Mi,l’K@ Current Hours| Lube/Service T pe| Mext MifKm Due|Next Hours Duz| Mexk Date D

D Reminders Popup
| o

Taxes,/Registrations Reminders

Equip Mum \Equip [esc |M0nth Req Due |Next Req Due |Next YT Due \Next HUT Cue |Next Insurance Renewal

Permits/Inspections Reminders
Equip Mum MNexk DOT Insp | Mesxk 90 Day Permit [Mext Annusl Sk| Next Over Axle Gross Permit | Next MCC | Next Smoke/CVIP

o1 FI1z{z006
Assigned # [Driver Name [coLe [Mext Phrysical [Mext COL Renewal

Parts Inventory Reminders |

Part # [MigPart #  [Desc [ty on Hand [Min Qby Before Reorder |Gy On Reorder

B Inbiox - Microsoft Qut,,, M f @ Elank Mailing Labels.d. ..

e Edit How Soon To Be Notified Button: Click this button and a window will pop-up
allowing you to enter miles, hours & days in advance that you would like to be notified
before an item is due.

e Pop-up Reminders Every: Select 1 to 8 hours from the dropdown list. This will set the
time interval to check for reminders while TATEMS is open.

e Print Inspection forms for All Equipment in List » : Click this button to print out a
separate blank inspection form for each item in the inspections reminder section. The
blank list can be passed out to the person doing the physical inspection.

e Print This List Button: Click this button to generate a printout of every item displayed
on the reminder screen.
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Tools
-El-sj_ﬁindnw Help

Metworking

Backup and Compact Data
pdate Sart Order
SimpliFy TATEMS

Special Ukilities 3

Tools/Networking

Tu:u:ulﬂ Window  Help ]
—- Metworking
Metworking 3
Networking
Backup and Cormpact Data The Data file you are currently accessing is in the box below. You can change the file you are
accessing by clicking on the folder to locate a different data file on the server, other computer or

IUpdate Sort Crder this computer
Simplify TATEMS Enket Path OF The Data File | slaslE=1] Files\TATEMS 2005\takems2005be.mdb =
Special Ukilities b Link Mo Clote

Tools/Networking

The program has to be installed on each computer that will need to run it. If you are using one
machine as a server that will not be running the program you will NOT need to install the
program on the Server machine. The Server machine only needs the tatems2005be.mdb file.
Please note that a license is required for each machine that runs the program. There is a
discounted, multiple license offer on the purchase page at http://www.tatems.com .

More networking instructions:

The file that holds the actual DATA that you have entered is called “tatems2005be.mdb”
Make a backup copy of this file. You will use it on the computer you want to act as the server.
So go ahead and copy it to the Server Machine.

In order to network TATEMS you will need to designate one of the computers as a server that
will store the data.

When you want to link the TATEMS software running on a workstation to the DATA FILE
on the server just click on Tools Networking.

Then click on the open folder icon to locate the DATA FILE on the SERVER.

The dialog looks like a file->open dialog for most other programs.

You will need to navigate to the tatemsbe2005.mdb file that is on the computer acting as a
server. The program seems to run best if you map a drive letter that points to the server

computer.

So you should navigate to something like
F:\Server\Program Files\TATEMS2005\tatems2005be.mdb

You should be able to just double-click on the file and the path will display in the box.

Then click on Link Now to link this copy of TATEMS to the DATA FILE.
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To Backup TATEMS Data:

In order to save and backup your data you need to make a backup copy of a file called
tatems2005be.mdb this is the file that contains all the data you enter into the program.
This file is in the folder C:\Program Files\TATEMS 2005\

The program needs to be closed whenever you backup or restore this file.

If you ever have to reinstall the program, you will need to restore this file back into it's folder
after reinstalling in order to work with the backed up data.

A couple of additional things need to be addressed here.
There is a Backup and Compact feature in TATEMS under Tools->Backup and Compact.

Tools/Backup & Compact Data
_-Tu:un.l.sz !__'u__'u'inu:h:uw Help
Metworking F'_

Backup and Compack Data | Backup and Compact Data

pdate Sart Order

Simplify TATEMS Close

Special Ukilities 3

The Backup and Compact feature only allows you to backup the data to the same folder where
the data file is housed. So if the data file is in C:\Program Files\TATEMS 2005\ then the
backup file will be created in that folder.

The backup file will be Date/Time stamped within the actual file name. It will look something
like this. tatems2005be7-19-2006-09-12.mdb
The 7-19-2006 is the date part and the 09-12 is the time part in 24 hour time (9:12AM).

This can be useful if you want to go back to a "point in time" backup to see where some mistake
was made or something went wrong.

These "point in time" backups and any backups for that matter should be moved off the hard
drive to a CR-R, a Zip drive, USB drive or memory card for safe keeping.

The "point in time" backups should also be moved off your hard drive because they can quickly
start taking up space, especially if you do them on a daily basis.

You can always link to a point in time backup by using the Networking Tool in TATEMS.

Under: Tools->Networking. This will allow you to see what's in a file without having to rename
it. Regardless of which approach you use to backup your data, you should do it on a daily basis.
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Tools/Update Sort Order

_-Tu:un.l.sz | Window  Help

Metworking
Backup and Compact Data

IIpdate Sart Order |

Simplify TATEMS

Special Ukilities 3

/2 sori | -

| Because the Equip MNum field is a text field it cannot

| sort nurnbers correctly. So the a nurmeric field caled

: Sort Order has been added to help with the sorting

| of the equiprment list and various reparts. You can

| eithier change the sort rmanualy by changing the Sort
’ Order Murnbers or let the program attermpt to create
| the sort order for you,

| Equip Mum Sart Order

oot |

(I | g

Auko Saork | Refresh | Close

The Sort Order screen is used to maintain the sort order of your equipment.

Because the Equipment Number field allows you to use letters and numbers it is a text field and

the sort order can become skewed and out of numerical order.

So a numerical field called “Sort Order” was added to each record to help overcome this

problem.

There are two ways that you can update the sort order field:

e You can use the Auto Sort button seen at the bottom of the Sort Order screen. When you
use the Auto Sort button, the system will attempt to create the best sort order based on the
characters in the Equip Num field. If you only use numbers in the Equip Num field, then
the Auto Sort will be quite accurate. If you use letters and numbers it may not be as
accurate. So you may need to adjust the numeric values in the sort order column.

e You can also create your own sort order manually by assigning a numeric value in the

sort order field to each equipment number.

Whenever you add a new piece of equipment you will be asked if you want to recreate the sort
order. If you choose yes, then the program will do the same thing as clicking the Auto Sort

button.
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Tools/Simplify TATEMS
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Use this form to remove Tabs from the TATEMS interface. When you un-check an item its
corresponding tab will stop displaying on TATEMS.

This can be useful if you don't use certain features in TATEMS or if you have certain people
using TATEMS that don't need those features.

Tools/Special Utilities

-E:u.l-sj_ﬁindnw Help

Metworking

Backup and Compact Data
Ipdate Sort Crder
Sirnplify TATEMS

SpeciEN_ItiIities ] Import Cld Data
&

Update Smoke Inspections
Idpdate 90 Day Inspections
Clean Up Data

Import Old Data

The import Old data utility is used only to import data from a pre-non TATEMS 2005 or 20/20
version into a TATEMS 2005 or 20/20.

Don't use this utility to try to import data from a TATEMS 2005 or 20/20 version to a TATEMS
2005 or 20/20 version. Instead, just link to the data using the networking tool, or simply copy
the data file to TATEMS directory
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Update Smoke Inspections
The update smoke inspections utility is obsolete and was used to update smoke inspections that
did not get properly updated while using a previous import utility.

Update 90 Day Inspections
The Update 90 Day Inspections utility is obsolete and was used to Update 90 Day Inspections
that did not get properly updated while using a previous import utility.

Clean Up Data

The clean up data utility can be used from time to time to remove un-needed inspections that are
no longer used by the system.

Equipment Search

|| Search ||b_l,.l Equiprment Mum j Filter|5h0w All jchoose | j Sort |b_l,.l E quipment Numj

e Enter an equipment ID number to view the records for a particular piece of equipment in the
Equipment Search field.

Or

e Use the drop down arrow to search by: Description, Make, Model, Year, License Plate # Cap
Equip # or PO Num

Search ”m_;’ Filter|8h0w All jchnnse | j Sort |b_l,l Equipment Numj

by Description

by bake

by Model

by vear

by Licenze Flatel

by Cap Equiph

by PO Mum hd

You can also use the Filter to filter the search list by Customer, Location or Department/Area.
After you choose one of those filter items then the Choose field next to it will populate with all
or your Customers or Locations or Department/Areas. Then your search will display only those
pieces of equipment that fit that filter criteria.

When entering text to search for, you can enter partial text and the search will search for things
that fit that partial match. For example, if you want to find all Chevys and Chryslers you could
enter the letter “C” and choose Search By Make.

Exit Program

e Click on File. Click on Exit Program to quit the program.
e You may also click on the X in the top right corner to quite the program.

Copyright © 1998-2006 PCHelp, Ltd. All rights reserved.
www.tatems.com
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